PASS Sample Size Software

NCSS.com

Chapter 376

Mixed Models Tests for
the Slope Difference in
a 3-Level Hierarchical
Design with Fixed
Slopes (Level-3
Randomization)
Introduction
This procedure calculates power and sample size for a three-level hierarchical mixed model which is randomized
at the third level. The goal of the study is to compare two group slopes. If the group means are identical at the
beginning of the study (which they often are in a randomized trial), testing the difference in slopes is the same as
testing the difference in means at the end of the study. This is a test of the time-by-treatment interaction.
The study is assumed to be longitudinal in that the third level is some type of cluster (e.g., clinic or hospital), the
second level is subjects nested within the third level, and the first level is a repeated measurement at equallyspaced time points on the subjects. Ahn, Heo, and Zhang (2015) call this a longitudinal cluster randomized
design.
The data are analyzed by considering the average trend of responses over time. These trends can be considered as
fixed (this procedure) or random (a companion procedure).

Randomization
Different models are used depending on how subjects are assigned to the intervention (treatment) groups. This
procedure assumes that all subjects (level-2 units) in a cluster (level-3 unit) are assigned to an intervention group
at random. This is called level-3 randomization. A companion procedure analyzes the case when subjects are
individually randomized to one of the two groups (level-2 randomization).
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Fixed or Random
The subject-specific slopes of responses across the repeated measurements can be assumed to be fixed or random.
In this fixed case, all subjects are assumed to share a common fixed slope with no variation. In the random case,
the slopes are assumed to have a normal distribution with a modelled variance.

Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.4.1.1, pages 201-203. The
hierarchical mixed model used for the analysis is
𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 = 𝛽𝛽0 + 𝜉𝜉𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖 + 𝜏𝜏𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝛿𝛿𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖 𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑢𝑢𝑖𝑖 + 𝑢𝑢𝑗𝑗(𝑖𝑖) + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖

where
𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖

is the continuous response of the kth level-1 unit of the jth level-2 unit of the ith level-3 unit.

𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖

is an integer that represents the time period. We assume that 𝑇𝑇𝑖𝑖𝑖𝑖𝑖𝑖 = 𝑇𝑇𝑘𝑘 and that these time values
increase from 0 (baseline measurement) to M – 1 (final measurement).

𝜉𝜉

is the intervention effect at baseline.

𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖
𝛽𝛽0

𝜏𝜏

𝛿𝛿

𝑢𝑢𝑖𝑖

is an indicator variable that is 1 if ijkth unit is in group 1 and 0 if it is in group 2.

is the overall fixed intercept.

is the slope of the time effect.
is the treatment effect of interest. It models the difference between the two group slopes.
is the level-3 random intercept effect for the ith level-3 unit. It is distributed as 𝑁𝑁(0, 𝜎𝜎32 ).

𝑢𝑢𝑗𝑗(𝑖𝑖)

is the level-2 random intercept effect for the j(i)th level-2 unit. It is distributed as 𝑁𝑁(0, 𝜎𝜎22 ).

𝜎𝜎 2

is the variance of Yijk, where 𝜎𝜎 2 = 𝜎𝜎𝑒𝑒2 + 𝜎𝜎22 + 𝜎𝜎32 .

C1

is the number of level-3 units (clusters) assigned to group 1.

C2

is the number of level-3 units assigned to group 2.

K

is the number of level-2 units (subjects) per level-3 unit.

M

is the number of level-1 units per level-2 unit, i.e., the number of repeated measurements.

𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖
𝜌𝜌

is a random error term which is distributed as 𝑁𝑁(0, 𝜎𝜎𝑒𝑒2 ).

is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like
this, 𝜌𝜌 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 , 𝑌𝑌𝑖𝑖𝑗𝑗𝑗𝑗 ′ � = (𝜎𝜎22 + 𝜎𝜎32 )/𝜎𝜎 2 .

The test of significance of the Xijk Tijk interaction term in the mixed model is the test statistic of interest. It tests the
difference of the two slopes.
The power can be calculated using
⎧
⎫
⎪ 𝛿𝛿 𝐶𝐶2 𝐾𝐾𝐾𝐾Var(𝑇𝑇)
⎪
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑟𝑟 = Φ � � �
− Φ(1 − 𝛼𝛼/2)
1
⎨ 𝜎𝜎
⎬
�𝑓𝑓3 (1 + )�
⎪
⎪
𝜆𝜆
⎩
⎭
where 𝜆𝜆 = 𝐶𝐶1 /𝐶𝐶2 , 𝑓𝑓3 = 1 − 𝜌𝜌, and Var(𝑇𝑇) = (𝑀𝑀 − 1)(𝑀𝑀 + 1)/12.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are δ, Power, C1, and K.
Under most situations, you will select either Power to calculate power or C1 to calculate the number of level-3
unit. Occasionally, you may want to fix C1 and C2 and calculate K.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found. This search considers only integer
values of C1, K, or M.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
C1 (Level 3 Units Assigned to Group 1)
This is the number of level 3 units (clusters) in group 1 (treatment group). The sample size for this group is equal
to Ceiling(C1 * K * M).
Examples of level 3 units are practices, clinics, hospitals, or doctors.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive integer.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
C2 (Level 3 Units Assigned to Group 2)
This is the number of level 3 units (clusters) in group 2 (control group). The sample size for this group is equal to
Ceiling(C2 * K * M).
Examples of level 3 units are practices, clinics, hospitals, or doctors.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive integer.
Using Multiples of C1
If you simply want a multiple of the value for group 1, you would enter the multiple followed by "C1", with no
blanks. If you want to use C1 directly, you do not have to enter the leading "1". For example, all of the following
are valid entries:
C1 2C1 0.5C1 1.5C1.
You can use a list of values such as "10 20 30" or "C1 2C1 3C1".
K (Level 2 Units Per Level 3 Unit)
This is the average number of level 2 units in each level 3 unit. Examples of level 2 units are subjects or patients.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive number that is at least 1.
It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up
to the next largest integer.
You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.
M (Level 1 Units Per Level 2 Unit)
This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated
measurements.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive number that is at least 1.
It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up
to the next largest integer.
You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.

376-4
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Fixed Slopes (Level-3 Rand.)

Effect Size
Slope Input Type
Select the input type for entering the difference in slopes. Two options are available: (μ1 - μ2) and δ.
•

μ1 - μ2 (Mean Difference)
Enter the difference in means at the final time point. The difference in slopes will then be calculated from this
value. This option is provided because this is a value that can be easily interpreted and should be readily
available.

•

δ (Slope Difference)
Enter values for δ directly. This option requires you to determine appropriate values for δ which will often be
difficult.

μ1 - μ2 (Mean Difference)
Enter one or more values for the mean difference where μ1 is the mean of group 1 at the final measurement and
μ2 is the mean of group 2 at the final measurement. This mean difference is used to calculate the difference in
slopes (δ) using the formula:
δ = (μ1 - μ2) / (M - 1).
This formula comes from the group-by-time interaction term in the mixed model which is δXT. Here, X indicates
whether the subject is a member of group 1 or not, and T is the time. Since this procedure assumes that the times
are 0, 1, 2, ..., (M-1), the value of T at the last measurement point is (M-1). Thus, δXT = δX(M-1) at the last time
point. This leads to the above formula.
The subject slopes are assumed to be fixed for all subjects within a group.
The power is the probability of detecting a δ of at least this amount. This value is not necessarily the true
difference. Rather, it is the difference you want to detect.
The difference, μ1 - μ2, can be any non-zero value (positive or negative). Since this procedure uses a is a twosided test statistic, you will get the same result with either positive or negative values.
Syntax
You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
δ (Slope Difference)
Enter one or more values for δ which is the difference between the group 1 and 2 slopes of the outcome over time.
This difference equates to the difference in means at the final measurement if the means at the first measurement
are equal (which is often the case for randomized trials).
The formula of the relationship between the group means at the final measurement is (μ1 - μ2) = δ (M - 1).
The slope of the measurements across time of all subjects in a group is assumed to be the same fixed value. The
power is the probability of detecting a difference of at least this amount between the two means (or slopes). This
value is not necessarily the true difference. Rather, it is the difference you want to detect.
Range: δ can be any non-zero value (positive or negative). Since this procedure uses a is a two-sided test statistic,
you will get the same result with either positive or negative values.
You can enter a single value such as 1 or a series of values such as 1 2 3 or 1 to 2 by 0.2. When a series of values
is entered, PASS will generate a separate calculation result for each value of the series.
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σ (Standard Deviation)
Enter the standard deviation of an individual observation, Yijk. This standard deviation applies for both groups.
Note that σ must be a positive number. You can enter a single value such as 5 or a series of values such as 1 3 5 7
9 or 1 to 9 by 2.
Press the small ‘σ’ button to the right to obtain calculation options for estimating the standard deviation.
ρ (Within Subject Correlation)
This is the correlation of each pair of repeated measurements within a subject.
Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.5.
You may enter a single value or a list of values.
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Example 1 – Calculating Power
Suppose that a three-level hierarchical design is planned in which repeated measurements (level-1) will be taken
on subjects (level-2) within hospitals (level-3). This analysis will calculate the power for detecting the difference
in slopes of two interventions.
The following parameter settings are used for the power analysis: μ1 - μ2 = 2.4; σ = 2.6; ρ = 0.1; K = 4; M = 4, 5;
α = 0.05; and C1 = C2 = 5, 10, 15, 20.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Fixed Slopes (Level3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... Power
Alpha .............................................................. 0.05
C1 (Level 3 Units Assigned to Group 1) ........ 5 10 15 20
C2 (Level 3 Units Assigned to Group 2) ........ C1
K (Level 2 Units Per Level 3 Unit) ................. 4
M (Level 1 Units Per Level 2 Unit) ................. 4 5
Slope Input Type............................................ μ1 - μ2 (Mean Difference)
μ1 – μ2 (Mean Difference) ............................. 2.4
σ (Standard Deviation) .................................. 2.6
ρ (Within Subject Correlation) ........................ 0.1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Three-Level Hierarchical Mixed Model

Power
0.6306
0.6817
0.9003
0.9306
0.9779
0.9879
0.9957
0.9982

Total
N
160
200
320
400
480
600
640
800

Group 1Group 2
Level 3 Level 3
Units
Units
C1
C2
5
5
5
5
10
10
10
10
15
15
15
15
20
20
20
20

Level 2
Units
K
4
4
4
4
4
4
4
4

Level 1
Units
M
4
5
4
5
4
5
4
5

Mean
Diff
μ1 - μ2
2.40
2.40
2.40
2.40
2.40
2.40
2.40
2.40

Std
Dev
σ
2.60
2.60
2.60
2.60
2.60
2.60
2.60
2.60

Level 1
Corr
ρ
0.100
0.100
0.100
0.100
0.100
0.100
0.100
0.100

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Ahn, C., Heo, M., and Zhang, S. 2015. Sample Size Calculations for Clustered and Longitudinal Outcomes in
Clinical Research. CRC Press. New York.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units.
C1 and C2 are the number of level-3 units assigned to groups 1 and 2, respectively.
K is the average number of level-2 units per level-3 unit.
M is the average number of level-1 units per level-2 unit.
μ1 - μ2 is the difference in the two group means at the final measurement time: M - 1. δ = (μ1 - μ2) / (M - 1).
σ is the standard deviation of the level-1 responses.
ρ is the correlation among level-1 units in a particular level-2 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.
Summary Statements
The total sample size of 160, which were obtained from 5 level-3 units in group one and 5
level-3 units in group two with an average of 4 level-2 units per level-3 unit and 4 level-1
units (repeated measurements) per level-2 unit, achieves 63% power to detect a difference
between the (fixed) group means at the last time of 2.40. The standard deviation of level-1
units is 2.60. The correlation of level-1 units within a level-2 unit is 0.100. A test based on
a mixed-model analysis is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power versus the level-3 count for the two values of M.
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Example 2 – Calculating Sample Size (Number of Clusters)
Continuing with the last example, suppose the researchers want to determine the number of clusters needed to
achieve 90% power for the values of M.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Fixed Slopes (Level3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... C1 (Number Level 3 Units)
Power ............................................................. 0.90
Alpha .............................................................. 0.05
C2 (Level 3 Units Assigned to Group 2) ........ C1
K (Level 2 Units Per Level 3 Unit) ................. 4
M (Level 1 Units Per Level 2 Unit) ................. 4 5
Slope Input Type............................................ μ1 - μ2 (Mean Difference)
μ1 – μ2 (Mean Difference) ............................. 2.4
σ (Standard Deviation) .................................. 2.6
ρ (Within Subject Correlation)........................ 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Three-Level Hierarchical Mixed Model

Power
0.9003
0.9038

Total
N
320
360

Group 1 Group 2
Level 3 Level 3
Units
Units
C1
C2
10
10
9
9

Level 2
Units
K
4
4

Level 1
Units
M
4
5

Mean
Diff
μ1 - μ2
2.40
2.40

Std
Dev
σ
2.60
2.60

Level 1
Corr
ρ
0.100
0.100

Alpha
0.050
0.050

This report shows the power for each of the scenarios.
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Example 3 – Validation using Ahn, Heo, and Zhang (2015)
Ahn, Heo, and Zhang (2015) page 204 provide a table in which several scenarios are reported. We will validate
this procedure by the first row of the table. The following parameter settings were for the analysis: power = 0.80;
δ = 0.3; σ = 4; ρ = 0.1; K = 8; M = 5; and α = 0.05. These settings resulted in a value of C2 (their N3(0)) of 32 and
an attained power of 0.807.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for the Slope Diff. in a 3-Level Hier. Design with Fixed Slopes (Level3 Rand.) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ....................................................... C1 (Number Level 3 Units)
Power ............................................................. 0.80
Alpha .............................................................. 0.05
C2 (Level 3 Units Assigned to Group 2) ........ C1
K (Level 2 Units Per Level 3 Unit) ................. 8
M (Level 1 Units Per Level 2 Unit) ................. 5
Slope Input Type............................................ δ (Slope Difference)
δ (Slope Difference) ....................................... 0.3
σ (Standard Deviation) .................................. 4
ρ (Within Subject Correlation)........................ 0.1

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Two-Level Hierarchical Mixed Model

Power
0.8074

Group 1 Group 2
Level 3 Level 3
Total
Units
Units
N
C1
C2
2560
32
32

Level 2
Units
K
8

Level 1
Units
M
5

Slope
Diff
δ
0.30

Std
Dev
σ
4.00

Level 1
Corr
ρ
0.100

Alpha
0.050

PASS calculates the same values of C2 and power: 32 and 0.807.
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